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USER NOTICE
No part of this manual, including the products and software described in it, may be reproduced,
transmitted, transcribed, stored in a retrieval system, or translated into any language in any form
or by any means, except documentation kept by the purchaser for backup purposes, without the
express written permission of ASUSTeK COMPUTER INC. (“ASUS”).

ASUS PROVIDES THIS MANUAL “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES
OR CONDITIONS OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
IN NO EVENT SHALL ASUS, ITS DIRECTORS, OFFICERS, EMPLOYEES OR AGENTS BE
LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES (IN-
CLUDING DAMAGES FOR LOSS OF PROFITS, LOSS OF BUSINESS, LOSS OF USE OR
DATA, INTERRUPTION OF BUSINESS AND THE LIKE), EVEN IF ASUS HAS BEEN AD-
VISED OF THE POSSIBILITY OF SUCH DAMAGES ARISING FROM ANY DEFECT
OR ERROR IN THIS MANUAL OR PRODUCT.

Product warranty or service will not be extended if: (1) the product is repaired, modified or
altered, unless such repair, modification of alteration is authorized in writing by ASUS; or (2)
the serial number of the product is defaced or missing.

Products and corporate names appearing in this manual may or may not be registered trade-
marks or copyrights of their respective companies, and are used only for identification or ex-
planation and to the owners’ benefit, without intent to infringe.

• NVIDIA, nFiniteFX, GeForce4, and Lightspeed Memory Architecture are registered trade-
marks of NVIDIA Corporation.

• Windows, MS-DOS, and DirectX are registered trademarks of Microsoft Corporation.
• Adobe and Acrobat are registered trademarks of Adobe Systems Incorporated.

The product name and revision number are both printed on the product itself. Manual revi-
sions are released for each product design represented by the digit before and after the period
of the manual revision number. Manual updates are represented by the third digit in the manual
revision number.

For previous or updated manuals, BIOS, drivers, or product release information, contact ASUS
at http://www.asus.com.tw or through any of the means indicated on the following page.

SPECIFICATIONS AND INFORMATION CONTAINED IN THIS MANUAL ARE FURNISHED
FOR INFORMATIONAL USE ONLY, AND ARE SUBJECT TO CHANGE AT ANY TIME WITH-
OUT NOTICE, AND SHOULD NOT BE CONSTRUED AS A COMMITMENT BY ASUS. ASUS
ASSUMES NO RESPONSIBILITY OR LIABILITY FOR ANY ERRORS OR INACCURACIES
THAT MAY APPEAR IN THIS MANUAL, INCLUDING THE PRODUCTS AND SOFTWARE
DESCRIBED IN IT.

Copyright © 2003 ASUSTeK COMPUTER INC. All Rights Reserved.

Product Name: ASUS V9950 Series
Manual Edition: First Edition V1  E1335
Release Date: May 2003
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ASUS CONTACT INFORMATION
ASUSTeK COMPUTER INC. (Asia-Pacific)
Address: 150 Li-Te Road, Peitou, Taipei, Taiwan 112
General Tel: +886-2-2894-3447
General Fax: +886-2-2894-3449
General Email: info@asus.com.tw

Technical Support
MB/Others (Tel): +886-2-2890-7121 (English)
Notebook (Tel): +886-2-2890-7122 (English)
Desktop/Server (Tel): +886-2-2890-7123 (English)
Support Fax: +886-2-2890-7698
Web Site: www.asus.com.tw

ASUS COMPUTER INTERNATIONAL (America)
Address: 44370 Nobel Drive, Fremont, CA 94538, USA
General Fax: +1-502-933-8713
General Email: tmd1@asus.com

Technical Support
Support Fax: +1-502-933-8713
General Support: +1-502-995-0883
Notebook Support: +1-510-739-3777 x5110
Web Site: www.asus.com
Support Email: tsd@asus.com

ASUS COMPUTER GmbH (Germany and Austria)
Address: Harkortstr. 25, 40880 Ratingen, BRD, Germany
General Email: sales@asuscom.de (for marketing requests only)
General Fax: +49-2102-9599-31

Technical Support
Support Hotlines: (Components) +49-2102-9599-0

(Notebook PC) +49-2102-9599-10
Support Fax: +49-2102-9599-11
Support Email: www.asuscom.de/kontakt (for online support)
Web Site: www.asuscom.de
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About this guide

Conventions used in this guide
To make sure that you perform certain tasks properly, take note of the
following symbols used throughout this manual.

Where to find more information
Refer to the following sources for additional information and for product
and software updates.

1. ASUS Websites
The ASUS websites worldwide provide updated information on ASUS
hardware and software products. The ASUS websites are listed in the
ASUS Contact Information on page 3.

2. Optional Documentation
Your product package may include optional documentation, such as
warranty flyers, that may have been added by your dealer. These
documents are not part of the standard package.

WARNING/DANGER: Information to prevent injury to yourself
when trying to complete a task.

CAUTION: Information to prevent damage to the components
when trying to complete a task.

IMPORTANT: Information that you MUST follow to complete a
task.

NOTE: Tips and additional information to aid in completing a task.
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Notices
Federal Communications Commission Statement
This device complies with FCC Rules Part 15. Operation is subject to the following
two conditions:

• This device may not cause harmful interference, and
• This device must accept any interference received, including interference that

may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a residential installation.
This equipment generates, uses and can radiate radio frequency energy and, if not
installed and used in accordance with manufacturer’s instructions, may cause harmful
interference to radio communications. However, there is no guarantee that interfer-
ence will not occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by turning
the equipment off and on, the user is encouraged to try to correct the interference
by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment to an outlet on a circuit different from that to which the

receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

The use of shielded cables for connection of the monitor to the graphics card is
required to assure compliance with FCC regulations.  Changes or modifica-
tions to this unit not expressly approved by the party responsible for compli-
ance could void the user’s authority to operate this equipment.

Canadian Department of Communications Statement
This digital apparatus does not exceed the Class B limits for radio noise emissions
from digital apparatus set out in the Radio Interference Regulations of the Canadian
Department of Communications.

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003
du Canada.

Macrovision Corporation Product Notice
This product incorporates copyright protection technology that is protected by
method claims of certain U.S. patents and other intellectual property rights owned
by Macrovision Corporation and other rights owners. Use of this copyright protection
technology must be authorized by Macrovision Corporation, and is intended for
home and other limited viewing uses only. Reverse engineering or disassemby is
prohibited.
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1.  Introduction
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Thank you for purchasing an ASUS V9950 Series GPU Graphics Card.
With this purchase, you join a legion of mainstream graphics enthusiasts.
Powered by the NVIDIA™ GeForce FX™ 5900Ultra/5900 graphics
processing unit (GPU), the ASUS V9950 series delivers breakthrough
leading-edge graphics performance.  Enjoy superior image fidelity
regardless of the CPU (central processing unit) employed by the computer
system.With the ASUS V9950 series, you will not only see but also
experience stunning, dynamic, realistic 3D worlds and characters.

Highlights
• Powered by the most programmable, precise and powerful

CineFX2.0 GPU: NVIDIA® GeForce FX 5900Ultra/5900
~ Delivers cinema-quality video to your PC.

• Built-in 256/128MB DDR frame buffer with 256-bit bus:
~ Provides the most resolution and color depth.

• Advanced  CineFX 2.0 shader engine:
~ Delivers 2x floating-point pixel shading power of our previous
generation.

• UltraShadow:
~NVIDIA® ‘s new patent pending shadow volume acceleration
technology, significantly enhances the performance for the latest
engines such as Doom 3 and Abducted.

• Intellisample HCT (Hi-resolution Compression Technology):
~ with new anisotropic algorithms, bring 50% efficiency improvement in
texture, color and Z compression than previous solutions, automatically
providing a boost to antialiasing.

• ASUS innovative GameFace Technology:
~real-time audio/video communication feature, elevates the interactive
gaming experience by enabling point-to-point video conferencing
functions and online gaming to take place simultaneously.

• AGP 8X support:
~By adding support for the newest AGP 8X (AGP 3.0) standard, the
V9950 series takes advantage of the new peak AGP bandwidth of 2.1
GB/s to offer even higher graphics.

• nVIEW™ display technology:
~ Supports TV encoder at 1024 x 768 resolution and two independent
display pipelines, providing the ultimate multiple display flexibility and
user control.

• Optimized for DirectX® 9.0 and OpenGL® 1.4 features:
~ Ensures broad application support.

• High-resolution LCD screen support
~ Supports up to 1600 x 1200 maximum LCD monitor resolution.

Actual screen resolution varies depending on LCD monitor resolution.
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2. Hardware Setup
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2. H/W
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Installation

2. Hardware Setup
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3. Resolution Table
Resolution Vertical Horizontal

Frequency Frequency

640 x 480 60Hz 31.5 √ √ √
70Hz 34.9 √ √ √
72Hz 37.9 √ √ √
75Hz 37.5 √ √ √
85Hz 43.3 √ √ √

100Hz 51.0 √ √ √
120Hz 61.8 √ √ √
140Hz 72.9 √ √ √
144Hz 75.2 √ √ √
150Hz 78.7 √ √ √
170Hz 90.3 √ √ √
200Hz 108.0 √ √ √
240Hz 132.9 √ √ √

800 x 600 60Hz 37.9 √ √ √
70Hz 43.8 √ √ √
72Hz 48.2 √ √ √
75Hz 46.9 √ √ √
85Hz 53.7 √ √ √

100Hz 63.7 √ √ √
120Hz 77.2 √ √ √
140Hz 91.1 √ √ √
144Hz 94.0 √ √ √
170Hz 112.7 √ √ √
200Hz 135.1 √ √ √
240Hz 166.2 √ √ √

1024 x 768 60Hz 48.4 √ √ √
70Hz 56.4 √ √ √
72Hz 57.5 √ √ √
75Hz 60.0 √ √ √
85Hz 68.7 √ √ √

100Hz 81.7 √ √ √
120Hz 98.8 √ √ √
140Hz 116.6 √ √ √
144Hz 120.2 √ √ √
150Hz 125.7 √ √ √
170Hz 144.1 √ √ √
200Hz 172.8 √ √ √
240Hz 212.1 √ √

1152 x 864 60Hz 53.7 √ √ √
70Hz 62.9 √ √ √
72Hz 64.9 √ √ √
75Hz 67.5 √ √ √
85Hz 77.1 √ √ √

100Hz 91.3 √ √ √
120Hz 111.2 √ √ √
140Hz 131.3 √ √ √
144Hz 135.2 √ √
150Hz 141.4 √ √ √
170Hz 162.9 √ √ √
200Hz 194.9 √ √

1280 x 960 60Hz 60.0 √ √ √
70Hz 69.9 √ √ √
72Hz 72.1 √ √ √
75Hz 75.2 √ √ √
85Hz 86.0 √ √ √

100Hz 101.7 √ √ √
120Hz 123.5 √ √ √
140Hz 145.1 √ √ √
144Hz 150.5 √ √
150Hz 157.2 √ √ √
170Hz 179.8 √ √

Color Depth
8bpp = 16bpp = 32bpp =
256 colors 65K colors 16.7M colors
Standard High Color True Color
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3. Resolution Table
Resolution Vertical Horizontal

Frequency Frequency

1280 x 1024 60Hz 64.0 √ √ √
70Hz 74.6 √ √ √
72Hz 76.8 √ √ √
75Hz 80.0 √ √ √
85Hz 91.3 √ √ √

100Hz 108.5 √ √ √
120Hz 131.7 √ √ √
140Hz 155.9 √ √ √
144Hz 159.6 √ √
150Hz 167.3 √ √ √
170Hz 191.8 √ √

1600 x 900 60Hz 55.9 √ √ √
70Hz 65.6 √ √ √
72Hz 67.5 √ √ √
75Hz 70.5 √ √ √
85Hz 80.4 √ √ √

100Hz 95.3 √ √ √
120Hz 115.4 √ √ √
140Hz 136.8 √ √
144Hz 140.4 √ √
150Hz 146.8 √ √

1600 x 1200 60Hz 75.0 √ √ √
70Hz 87.5 √ √ √
72Hz 90.1 √ √ √
75Hz 94.0 √ √ √
85Hz 106.1 √ √ √

100Hz 127.5 √ √ √
120Hz 154.5 √ √

1920 x 1080 60Hz 67.1 √ √ √
70Hz 78.7 √ √ √
72Hz 81.1 √ √ √
75Hz 84.6 √ √ √
85Hz 96.4 √ √ √

100Hz 113.9 √ √

1920 x 1200 60Hz 74.6 √ √ √
70Hz 87.4 √ √ √
72Hz 90.0 √ √ √
75Hz 94.0 √ √ √
85Hz 106.7 √ √ √

100Hz 126.7 √ √

1920 x 1440 60Hz 89.4 √ √ √
70Hz 104.9 √ √ √
72Hz 108.5 √ √
75Hz 112.5 √ √ √
85Hz 129.4 √ √

2048 x 1536 60Hz 95.5 √ √ √
70Hz 111.9 √ √
72Hz 115.3 √ √
75Hz 121.3 √ √

Color Depth
8bpp = 16bpp = 32bpp =
256 colors 65K colors 16.7M colors
Standard High Color True Color
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4. ASUS GameFace

4.1 Introduction

The revolutionary ASUS GameFace is a real-time audio/video
communication feature that enhances interactive gaming experience by
enabling point-to-point video conferencing functions and online gaming to
take place simultaneously thus allowing you to see and talk to your
opponents while playing full-screen online games!

Visit the ASUS website (www.asus.com) for more information about the ASUS
GameFace technology.
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4.2 Installing ASUS GameFace

Follow the given instructions to install ASUS GameFace.

1. Insert the CD installation disc
into your CD-ROM drive or
double click the CD drive icon in
My Computer to bring up the
autorun screen or run
Setup.exe in the root directory
of your CD-ROM drive.

Click Utilities.

2. The Utilities box appears.
Click Install ASUS
GameFace.

3. From the Welcome box, click
Next to start the installation.

To complete the installation,
simply follow the on-screen
instructions or prompts.

4. Click Finished after the
installation is complete.
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4.3 Using ASUS GameFace

Follow the given instructions to use ASUS GameFace.

• Open Display Properties
dialog box from desktop or
control panel.

• Select Advanced tab on
Settings page.

• Select OSD from in Advanced
tab.

• Check the Enable OSD check
box and input the appropriate
hotkey.

• ASUS GameFace automatically
detects the connected audio/
video WDM capture device
upon start-up. You can change
the input device from Options
in the Tool menu if you have
more than one audio/video
device.

STEP 2: Launch ASUS GameFace

STEP 1: Enabling ASUS OSD

You can also enable the On-
Screen Display (OSD) in the
GameFace application.
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STEP 3: Local Playback Mode

• Select Local Play/Stop from
the File menu to start local
playback when local video is not
playing.

• Select Local Play/Stop from
the File menu to stop local
playback when playing local
video.

• You can also press the
Play/Stop button to start or stop
local playback.

STEP 4: Network Playback Mode

• Connect to remote computer:

- Input the computer name
(Local Area Network) or IP
Address in the combo box.

- Select New Call from the
File menu or press the
“Make a Call” button.

- You will see and hear the
remote audio/video signal if
the remote computer
accepts the call.

For computer name and IP
addresses go to Tools->Info
for lists of information.
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• Waiting for connection:

- Launch ASUS GameFace

- A message box appears on
an incoming call. Click Yes
to accept the call.

- Select End Call from the
File menu or press the
“End the Call” button to
disconnect.

STEP 5: GameFace Settings

• Select Option from the Tool menu.

• Select GameFace Option Dialogue

• Enter GameFace page to adjust transparency, position and hotkey
settings.
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STEP 6: Launch Game and show GameFace

• Begin your game.

• After entering Full-Screen mode, press the hotkey
(default is Ctrl+Alt+V) to activate GameFace.

• Press the On-Screen Display hotkey to show the OSD menu.

• Use the arrow keys to select the GameFace application page and
adjust the Transparency, Position X, Position Y, Size or toggle to
enable or disable GameFace.
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